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1.  Training Agenda 

Trainee Agenda 
1. Tranquility Portfolios 

a) What is Tranquility? 

b) How does Tranquility work? 

c) What is a portfolio? questionnaire? document? 

d) Why use Tranquility to generate documents/forms? 

2. Overview of the System 
a) Starting Tranquility 

b) Electronic Filing System - Directory Structure 

c) Creating a New Portfolio 

d) Working in the Portfolio 

i) Navigating through the Questionnaire 
ii) Providing Answers 

e) Previewing and Printing the Completed Document 

f) Opening an Existing Portfolio 

i) Modifying Answers to the Questionnaire 
ii) Selecting Different Questionnaires 

3. Hands-On Experience - Chapters 4, 5 and 7 as needed 

a) Create a New Portfolio  

i) Provide Answers to a Questionnaire 
ii) Preview the Completed Document 

b) Open an Existing Portfolio 

i) Modify Answers to the Questionnaire 
ii) Preview the Completed Document 
iii) Selecting Different Questionnaire 

4. Questions and Discussion 
a) Review of Overall Process 

b) "Quiz" over program 

c) Evaluation of Training 
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2.  PowerPoint Handouts 

Tranquility for Special Education

Case Management Training

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

  

Why Are We Here?

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Tranquility Case Management

Purpose of Workshop…..

   The purpose of this training is to develop
your ability to use the Tranquility Case
Management software so that you can
easily and quickly create and maintain
documentation (e.g., letters, IEPs, etc.)
for special education.

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

What is Tranquility?

Tranquility….
Is a Microsoft windows-based document generation
system
Interfaces with your compatible student information
system (SIS)
Permits  you to easily store and retrieve completed
documents
Allows district to easily transfer and retrieve data
across networks
Sequences you through the entire special education
process from referral to exit

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Tranquility Case Management
Tranquility benefits you by….

Eliminating the need to complete a form by
hand.
Producing more complete, easier to read and
fully documented reports.
Eliminating the need to key duplicate
information into your reporting program

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

Tranquility Case Management
Tranquility benefits you by (continued)....

Allowing you to create multiple forms and
documents from one set of questions and
answers.
Allowing you to make minor touch-ups  and
modifications using Microsoft Word.
Saving you time

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Tranquility Case Management
Training Overview

Day One
Program introduction
and description
Overview of the
system
Hands-on experience

Day Two
Share questions and
experiences
Review techniques
Continue hands-on
experience using an
actual IEP
Gain greater insight
into program details

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

Tranquility Case Management

Specific Goals for Day One
Learn the basic concepts (portfolio, questionnaire,
document) of the case management program
Learn the different types of questions you will see
in your questionnaires
Learn how to create and maintain portfolios
Learn how to generate forms/documents
Learn common user errors

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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2.  PowerPoint Handouts 
 
 
 

HOW Tranquility WORKS

Core Reporting
•Create & Maintain Data
•Federal/State Report

      
Case  Management
•Portfolio
•Questionnaire
•Documents

WORD

Tranquility for Special Education

SIS (e.g. SASIxpTM)

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

District Integration

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Tranquility Case Management

What is a PORTFOLIO?
– Online version of your paper-based file folder
– Contains information about a student

Portfolio

Doe, J. - PF

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

Tranquility Case Management

What is a QUESTIONNAIRE?
– A series of questions answered by user
– Sequenced according to your forms and

compliance laws

Individualized Educational Program
Student Name_________________  DOB______________

Parents:_______________  Phone Number_____________

Address:________________________________________

Primary Disability:________________________________

Date of IEP Meeting:_________ Annual Review:_______

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Tranquility Case Management

What is a DOCUMENT?
– Online form based on your paper-based form

• Generated in Microsoft Word format
• Creates an online historical paper trail

Portfolio

IEP

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 

 

  

Overview of the System

An overview demonstration of the Case
Management front-end will now begin.

(Agenda item 2)

Please note that you will have an icon on your
desktop to start the application.

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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Support Questions
Tranquility Software Support

End Users

School 1
Tranquility Main Contact

Name
Phone/Email

End Users

School 2
Tranquility Main Contact

Name
Phone/Email

Tranquility Administrator (District)
Name Here

Phone
Email

Tranquility Solutions, Inc.
Software Support
1-888-606-7196

support@tranquilitysolutions.com

 

Notes:  
___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________

___________________________________ 
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General Notes 
 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 
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3.  Describing Question and Answer Screens 

Question Types 
During the documentation processes of special education, you provide responses to questions in a 
variety of ways.  Some of your responses are in the format of a date, narrative, list, etc.  In Tranquility 
you will notice the same flexibility as you are prompted for information. 

There are a variety of question types that may exist within any questionnaire in Tranquility.  The five 
question types are: 

Date, • 

• 

• 

• 

• 

• 

Text (open-ended narrative), 

Multiple Choice (one selection allowed), 

List (multiple selections allowed), and  

Informational Only (no selections allowed), and 

External programs (screens which contain special/multiple functions). 

A description and screen shot of each question type will follow in this chapter to assist you in 
becoming familiar with the different question types and how to respond to each. 
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The Question and Answer Screen (Date, Text, Multiple Choice, and List) 
Note:  External questions are documented in the next section. 

The question and answer screens for date, text, multiple choice and list questions are composed of 
three basic areas. 

 
 
 
Question Area 
 
 
 
 
 
 
 
 
 
Answer Area 
 
 
 
 
 
 
Navigational Buttons 

The Question Area 

Located near the top of the screen, the question area is read-only.  This area prompts the user for 
some specific information.  In addition, a brief informational paragraph can be included to help guide 
the user to appropriately respond. 
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3.  Describing Question and Answer Screens 
 
 
 

The Answer Area 

Located near the middle of the screen, the answer area allows the user to respond based on the 
question type.  Following is an example of each: 

Date 
The “date” question type allows the user to enter a date in the MM/DD/YYYY format.  The 
answer area is populated as the user enters the date. 

Text 

The “text” question type allows the user to respond in an open-ended text format.  In other words, 
the response is not limited to a few lines.  The user can expand upon his/her answer as needed. 
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Multiple Choice 

Action 
icons 

The “multiple-choice” question type allows the user to select an answer from a predefined* list of 
choices.  Users are only allowed to select an answer that appears in the Selected Choice area 
when chosen. 

You can select a choice by: 

Highlighting a choice and pressing Enter, or • 

• 

• 

Double-clicking on a choice, or 

Clicking on the action icons between the Choose One From and Selected Choice 
boxes. 

Note:  The length of some options may exceed the width viewable on the screen.  To see the entire 
option, simply highlight it and press F5.  You will see the entire option displayed in the upper right-
hand corner of the screen.  Pressing any key will release the display. 

 

 

 

 

 

 

 

 
____________ 
* The school district informs Tranquility Solutions of the desired picklist.  Users are only 

“locked” into a set of answers if deemed appropriate by the district.  An “Other” option allows 
for a user to provide information beyond the list of choices. 
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List 
 

Action 
icons 

 
 

The “list” question type allows the user to select multiple answers from a predefined* list of 
choices.  The answer(s) appear in the order chosen in the Selected Choices area.  This order is 
also reflected in the generated documents. 

You can select a choice by: 

Highlighting a choice and pressing Enter, or • 

• 

• 

Double-clicking on a choice, or 

Clicking on the action icons between the Choose One From and Selected Choice 
boxes. 

Note:  The length of some options may exceed the width viewable on the screen.  To see the entire 
option, simply highlight it and press F5.  You will see the entire option displayed in the upper right-
hand corner of the screen.  Pressing any key will release the display. 

 

 

 

 

 

 

 

 
____________ 
* The school district informs Tranquility Solutions of the desired picklist.  Users are only 

“locked” into a set of answers if deemed appropriate by the district.  An “Other” option allows 
for a user to provide information beyond the list of choices. 
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Information Only 

 

The "information only" question type allows the user to gain greater knowledge as to how the district 
wants him/her to respond to upcoming questions.  In addition, it can be used for general reminders as 
well.  This is a read-only screen and thus does not allow for any inputting of information from the 
user. 

 

22 For Software Version 5.0 



3.  Describing Question and Answer Screens 
 
 
 

The Navigational Buttons 
 

Information boxes appear as well to indicate 
the current questionnaire and student. 
 

Question 
Next:  Moves user to the next question in the questionnaire, one question at a time.  The “next” 
question may be contingent on how you respond to the current question.  In other words, if you 
have a Yes/No question, selecting “Yes” may take you to one question, while selecting “No” 
takes you to another.  Tranquility eliminates the need for the user to be concerned with 
compliance from a sequencing of questions perspective. 

• 

• 

• 

Previous:  Moves user to the previous question in the questionnaire, one question at a time. 

Goto:  Allows user to randomly select which question to jump to in the questionnaire.  The Goto 
list is comprised of unindented questions.  Unindented question (e.g., Does this student need an 
ITP?) may have a series of indented questions contingent on your response.  These indented 
questions do not appear on the Goto list.  The following is a sample screen shot of a Goto list of 
questions with an explanation of each column. 

¾ Questions: The first column displays the 
list of questions that you may jump to. 

¾ Required Questions: The second column 
(asterisks) indicates if the question is 
‘required.’  Tranquility informs you which 
required questions you did not respond to 
during the Generate process, but does not 
force you to provide an answer.  Forcing 
you to answer questions would prevent you 
from creating a draft IEP. 

¾ Yes/No Indicator: The third column 
indicates if a response is present for the 
question.  This visual indication allows the 
user to quickly review if any ‘required’ 
questions have not been answered.  Keep in 
mind that indented questions are not 
displayed and may not have been 
answered. 
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End:  Terminates the question and answer interactive session for this questionnaire.  Please note 
that answers are saved** when you move from one question to the next. 

• 

 

Person  
Next:  This feature is not available in Tranquiliy for Special Education. • 

• 

• 

Previous:  This feature is not available in Tranquility for Special Education. 

Review:  Provides a read-only view of basic demographics for a student. 

 
 
____________ 
** External program questions require a Save on the screen.  You will notice a Save button for 

this function.  All other questions perform an auto-save upon leaving the screen. 
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3.  Describing Question and Answer Screens 
 
 
 

The Question and Answer Screen (External Program Questions) 
The external program questions, which are more comprehensive in their functions, access the core 
reporting screens. 

Sample Core Reporting Screen 

 
 
 
Demographic 
Information 
 
 
 
 
Data Entry 
Fields 
 
 
 
 

 
 
 
Ellipsis lookup 
buttons – 
Access lookup 
codes and 
descriptions to 
assist in data 
entry. 

The core reporting screens are consistent in functionality and layout but differ in content as reporting 
and goals and objectives screens as appropriate. 
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Goal Area 
 
 
 
 
Objectives 
and related 
information 
associated 
to the 
above goal. 
 
 
Action 
buttons 

 
Sample Goals & Objectives Screen: 

Note:  When providing information for the Goals & Objectives screen, do not use double quotes 
(“).  Doing so will not effect the saving of your data, but may result in partial display of the data upon 
generating a document. 

The length of some objectives may exceed the width viewable on the screen.  To see the entire 
objective, simply highlight it and press F5.  You will see the entire objective displayed in the upper 
right-hand corner of the screen.  Pressing any key will release the display. 
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3.  Describing Question and Answer Screens 
 
 
 

Multi-Select Functionality for Goals and Objectives Screen 
The multi-select functionality is available to all appropriate lookup tables associated with the Goals 
and Objectives screen.  This will allow users to more efficiently populate the Goals and Objectives 
screen. 

Note: Certain tables are still single select.  For example, Tranquility’s Goals and Objectives page is 
designed to document one goal and all of the supporting data for that goal.  Therefore, a user is able 
to select only one goal from the lookup table.  Additionally, if your state has other fields where 
business rules indicate that only one selection is allowed, then Tranquility has maintained those 
lookups as single selection as well.  If your district feels any of your tables should be multi-select that 
are not, please contact Tranquility Solutions’ Support. 

The lookup window title bar now displays the corresponding table name as displayed on the 
Maintenance-Special Ed. Tables menu.  This assists those staff members responsible for 
maintaining the lookup lists for the entire district. 
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Selecting Goals 

1. To select a goal, you still press F5 within the Goal ID field.  Now, the following window 
appears: 

 

2. To see a full description of a goal highlight the goal and press F5.  Pressing F5 will display 
the entire description in a pop-up window in the upper-right-hand corner of your screen.  
Touching any key will release the pop-up window. 
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3. Although the screen appears to allow multi-select of goals, notice that the Mark All and 
Unmark All buttons are not activated.  This indicates the goal selection is a single select 
function.  To select a goal, use one of the following methods: 

a. Double click on the goal. 

b. Highlight the goal and press Enter. 
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Selecting Additional Goal and Objective Fields (except Objectives) 

The ability to multi-select objectives has been a favorite of Case Management users.  Therefore, 
Tranquility Solutions has expanded this concept to additional lookup lists on the screen.  The 
selection of objectives remains as it was in Version 4.5. 

An example of this expanded functionality is below, using the Evaluation Methods lookup list. 

1. With your cursor placed inside the desired lookup field, press F5.  The following window 
appears: 

 

2. To select a record or item from the list, 

a. Double click on the item 

b. Highlight the item and press Enter. 

3. You may use the F5 key to pop-up the entire description of an item as described above in the 
Goals selection area. 

4. Once an item has been selected, you will see a checkmark (√) appear to the left of the item.  
To deselect an item, simply double click on it again or highlight it and press Enter.  Using 
the Mark All button will select all of the items while using the Unmark All will deselect all 
items. 

5. Once you have the items selected you want, press OK to return to the main Goals and 
Objectives screen. 
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Including Records in Case Management Document Generation 
Note: If your district does not utilize any Core Reporting screens in your questionnaires, this section 
does not apply.  Furthermore, your district should configure the System Setup Options to suppress the 
warning messages associated to this field. 

If your district does not use Core Reporting screens within your Case Management questionnaires, 
you may leave this field unchecked.  If your district does include Core Reporting screens within your 
questionnaires, you should read the remainder of this section. 

A user (Case Management or Core Reporting) can ensure a particular record is included in document 
generation by placing a checkmark in the Include in CM field, regardless of the data (status, end 
date, etc.).  Note that the location of the field varies from screen to screen. 

Upon saving the record, a checkmark will appear in the list box, indicating the record has been 
marked for inclusion during document generation. 

Important Note: If Case Management users access a Core Reporting screen in a questionnaire, each 
record on each Core Reporting screen that should be included in the generated output must be edited 
and have a checkmark entered in this field.

Include in CM Field 
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If your district wants to prompt you to check the Include in CM field for active records only upon a 
save, the following are messages that you may see. 

Warning 1 

This warning appears upon a Save if the Include in CM option is unchecked and the record is active 
(i.e., there is not an ending or terminating date within the record).   

It is generally assumed that an active record would be included on current documentation.  The user 
however can make the determination as to whether or not the record is to be included. 

Warning 2 

This warning appears upon a Save if the Include in CM option is checked and the record is inactive 
(i.e., there is an ending or terminating date within the record). 

It is generally assumed that an inactive or terminated record would not be included on current 
documentation.  The user however can make the determination as to whether or not the record is to be 
included. 
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Multi-section Screens 
Tranquility has several Core Reporting screens that contain two data entry areas within the screen.  
The Assessment screen is an example of this type of screen as it has two sections, a header and detail, 
where most screens have simply one section.  The data entry in the header area is accessible when the 
user presses Add on the toolbar.  The data entry in the detail area is accessible when the user presses 
the Add on the screen itself, which is towards the bottom right of the screen.  You may have other 
screens within your district, which work in a similar manner. 

 

 

 

 

Header Data 

Detail Data 

 
 

In addition to having the two sections as noted above, these screens may allow for the user to define 
other data depending on the selections they make.  The district configures various system parameters 
that determine which records may be further defined. 
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Assessment Screen -- Other Tests 
This memo field allows you to enter a test name that is not defined in your lookup table of tests.  As a 
general practice, the district should define all possible tests in the lookup, but exceptions may always 
arise.  Therefore, your district should include a test code and description, such as 9999 Other … in 
the Tests Lookup table.  Then, via configuration of the System Setup Options screen, your 
Tranquility Administrator will select this other test code to allow you to further define the test. 

1. Press Add (or Edit to modify an existing test).  The following window appears: 

 

2. Locate the test record that is to be used to define an “other” test, highlight it and press OK.  
In the sample screen above this would be record 9999. 

3. If you selected the appropriate record and the system is configured correctly, you will now 
have access to the Other Tests memo field.  Otherwise the field remains inactive (grayed 
out). 
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4. Press the Other Tests button.  The following window appears: 

 

5. Enter the Other Test information as appropriate. 

6. Press OK.  Note that a checkmark appears on the Other Tests button, which is similar to 
other memo fields in Tranquility. 
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Assessment Screen -- Other Accommodations and Modifications 
Similar to the Other Tests above, you can now define “other” accommodations and modifications.  
The district will need to ensure that proper configuration exists, including an “other” 
accommodation/modification code.  In addition to this new feature, the district can also configure 
existing accommodation/modification records to allow for further description.   

For example, let’s say that you have an accommodation of “Allow use of calculator”.  However the 
student may not use a graphing calculator.  Therefore you need the ability to further define the 
accommodation to note this information.  To visually determine which accommodation/modification 
records permit additional information, look for a consistent character at the end of each record such as 
a colon (:).  If you cannot determine this, contact your Tranquility Administrator. 

1. Ensure you are adding or editing an assessment record. 

2. In the Accommodations and Modifications area of the screen, press Add.  The 
following window appears: 

 

3. Select the “other” record and/or records that permit additional information. 

4. Press OK. 

5. Press Save. 
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6. Note that each accommodation/modification record that you select which is configured to 
allow for additional information will result in the Other field being active or bold. 

7. To enter additional information on a specific record, highlight the record and press Edit (in 
the lower portion of screen). 

8. Press Other.  The following window appears: 

 

9. Enter the other information. 

10. Press OK.  Note that a checkmark appears on the Other button, which is similar to other 
memo fields in Tranquility. 
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Completed Assessments Sample Screen 
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General Notes 
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How to Create an Electronic Portfolio 
 
1. Double click on the Tranquility icon.  The following 

window appears: 

 

2. Enter your Account and press Enter.  Then type your 
Password, and click OK. 

Note:  Clicking with your mouse pointer in either the 
Account or Password cells, may result in a message that 
indicates that your Account or Password cannot be found.  
This is due to the pointer not being positioned in the left-
most part of the cell. 

3. From the File menu, select New. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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3a.  When logging in to Tranquility Case Management, you may 
receive the following message: 
 
 

 
 
 
 
This message indicates that you have been given assignments in 
the Referral Activities screen in Core Reporting for one or more 
referral activities (e.g., observations, evaluations, behavior 
checklists).   
 
You may print the list of activities due you have been assigned 
by responding Yes to the prompt.   The following screen 
message will appear: 
 
                              

 
 
 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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If you wish to view the report without printing, click OK.  The 
report will post to your screen: 
 
                 

 
 
If you choose to print the report, you will receive the Select 
Printer screen and you can choose where you wish to print. 
After the report has printed to either the screen or your printer, 
Tranquility’s main screen will appear. 
 
If you chose NO to the prompt: 
 

 
 
you will be taken directly to the main screen. 

 

 

 

4. Highlight the questionnaire you wish to generate then click 
OK. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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5. Select the name of the student for whom you are creating the 
portfolio by highlighting their name and pressing the 
ENTER key.  You can filter the list of students based on the 
first character of the student’s last name.  Press any letter to 
redisplay the list of students.  This assists users that may 
create a portfolio at the district level. 

 

If you do not see a student name on the 
right side of the screen, you have not 
selected a student yet. 

 

 

Notice 
that the 
student 
you 
selected 
now 
appears 
in the 
right 
hand box 
on the 
screen. 
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6. Click OK. 

Note:  You must select a student on the Select People screen 
prior to clocking OK.  Failing to do so generates the 
following prompt: 

 

  

 
 

 

 

 

 

Before proceeding you need to: 
• 
• 
• 

Click the OK button 
Repeat steps 5 and 6 
Then choose Save from the File menu, before 
proceeding with step 7. 

 
 
 
 
 

If a student already exists in a portfolio, you will not 
be able to select or add the student to another 
portfolio.  Attempting to do so results in the 
following system prompt: 

 
 

 
 
 
 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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7.  The Portfolios directory is hightlighted.  Click OK. 

Notice how 
the program 

automatically 
provides the 

File Name 
based upon 
the student 

you selected. 

 

Should you attempt to save the portfolio in a directory other 
than the root (i.e. a school year directory), you will see the 
following message: 

 

 

 
Click OK and you will be taken back to the 
Portfolios directory to save the new portfolio. 
 
Note:  Portfolio names may be up to 40 characters 
in length. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

      

46 For Software Version 5.0 
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8.  Click OK.  Your screen should now look similar to the 
following screen.  Note that the Portfolio, Questionnaire, 
and People box are populated appropriately. 

 

9. To begin answering questions within the questionnaire, click 
on the Provide Answers push button at the top of your 
screen.  Each time you choose to provide answers within a 
student's portfolio, the date/time stamp is automatically 
updated. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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10. The first question of the selected questionnaire appears on 

your screen.  You can provide an answer, or move to other 
questions by pressing the navigation buttons for questions at 
the bottom of your screen. 

Navigation Buttons for Questions 

 

• 

• 

• 

• 

The Next button takes you to the next question in the 
sequence of questions. F8 on your keyboard is also 
reserved for this movement. 
The Previous button takes you to the previous question 
in the sequence of questions. F7 on your keyboard is 
also reserved for this movement. 

The Goto button will provide a list of questions that 
you can easily jump to from an existing question.  If you 
use the Goto button you can also quickly find out if a 
question has an answer associated with it and whether a 
question is required.  A Yes indicates that an answer is 
present.  A No indicates that no answer is present. 

In addition, the F9 key will access the designated hot 
key question (e.g., Case Conference notes).  Press F9 
once to jump to the designated question.  After 
reviewing/providing information on the designated 
question screen, press F9 again to return to the question 
from which you left. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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11. When you have completed answering all of the questions, a 

message will appear alerting you that you have reached the 
end of the questionnaire. 

 

• If you are finished with this questionnaire and answer 
session, click OK.  This option will return you to the 
main portfolio screen. 

• If you would like to remain in the questionnaire, select 
the “Remain with this person” radio button, then 
click OK. 

12. Once you have finished with the questionnaire and have 
returned to the main screen, you simply click on the 
Generate push button located at the top of your screen to 
view and/or print your portfolio component. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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13. Select the document you would like to generate by 

highlighting its title and clicking OK. 

 

 

The Answers document does not generate via 
Microsoft Word.  It simply generates a non-formatted 
report in FoxPro.  Therefore, it is rarely selected to 
generate. 

14. Highlight the directory in which you would like to save this 
document (i.e., 2003/2004 Documents). 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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If you choose to save the document in the root directory 
(e.g., Portfolios), you will see the following message: 

 

 

Click OK: 

Return to the Directory Manager and highlight the 
correct school year. 

15. Click OK.  Tranquility will start Microsoft Word remotely if 
it is not currently running.  You will notice a Please Wait… 
message box in the upper right hand corner of your screen as 
the program creates the output.  The completed document 
will appear on your screen when completed.  If not, you can 
simply click on Microsoft Word on your taskbar. 

 

The generated output is simply a word processing 
document that you can edit.  If you need to change 
any data that you provided, it is recommended 
you return to Tranquility to make the changes 
permanent.  Any changes made in the word 
processing document are only temporary. 

• 

• 

• 

To print the document, from the File menu, 
select Print.   
Prior to returning to Tranquility, it is 
recommended that you close the open 
document(s) by selecting Close from the File 
menu. 
To return to Tranquility, click on the 
Tranquility icon on the taskbar. 

Hint:  It is not recommended that you exit (i.e., 
Do not choose Exit from the File menu.) 
Microsoft Word each time you return to 
Tranquility if you intend to generate additional 
documents.  Doing so, will increase generation 
time. 
 
 
 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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16. If you want to: 

• Continue working with the current portfolio, press 
Provide Answers to resume the question and answer 
interactive session, or Generate to create additional 
documents. 

• Work in another portfolio, from the File menu choose 
Close. 

17. To close Tranquility, select File then Exit from the menu 
bar. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

 
Security Note 

If you must leave your computer unattended for a short amount of 
time, you may lock Tranquility via the Options – Screen Lock 
function. 

                        
This will freeze the application until your password is entered.  
This function is not available within a questionnaire.   

Note:  For greater security, it is always recommended that you 
log out of the application completely. 
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How to Update an Existing Electronic Portfolio 
 

1. From the File menu, select Open. 

 

2. Highlight the name of the student portfolio to open. 

 

 

If a portfolio has been saved in a non-root 
directory (i.e. a school year documents directory), 
it is strongly recommended that you review your 
business processes with your Tranquility 
Administrator. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

___________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

 

3. Click OK.  The portfolio main screen is now on your 
desktop. 
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4. To begin answering/changing questions within the 

questionnaire, click on the Provide Answers push button 
at the top of your screen.  Each time you choose to provide 
answers within a student's portfolio, the date/time stamp is 
automatically updated. 

 
5. The first question of the selected questionnaire appears on 

your screen.  You can provide an answer, or move to other 
questions by pressing the navigation buttons for questions at 
the bottom of your screen. 

Navigation Buttons for Questions 

 

• 

• 

• 

• 

The Next button takes you to the next question in the 
sequence of questions. F8 on your keyboard is also 
reserved for this movement. 
The Previous button takes you to the previous 
question in the sequence of questions. F7 on your 
keyboard is also reserved for this movement. 
The Goto button will provide a list of questions that 
you can easily jump to from an existing question.  If you 
use the Goto button you can also quickly find out if a 
question has an answer associated with it and whether a 
question is required.  A Yes indicates that an answer is 
present.  A No indicates that no answer is present. 

In addition, the F9 key will access the designated hot 
key question (e.g., Case Conference notes).  Press F9 
once to jump to the designated question.  After 
reviewing/providing information on the designated 
question screen, press F9 again to return to the question 
from which you left. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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6. When you have completed answering all of the questions, a 

message will appear alerting you that you have reached the 
end of the questionnaire. 

 

• If you are finished with this questionnaire and answer 
session, click OK.  This option will return you to the 
main portfolio screen. 

• If you would like to remain in the questionnaire, select 
the “Remain with this person” radio button, and 
then click OK. 

7. Once you have finished with the questionnaire and have 
returned to the main screen, you simply click on the 
Generate push button located at the top of your screen to 
view and/or print your portfolio component. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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8. Select the document you would like to generate by 

highlighting its title and clicking OK. 

 

 

The Answers document does not generate via 
Microsoft Word.  It simply generates a non-formatted 
report in FoxPro.  Therefore it is rarely selected to 
generate. 

9. Highlight the directory in which you would like to save this 
document (i.e. 2003/2004 Documents). 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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If you choose to save the document in the root directory 
(e.g., Portfolios), you will see the following message:  

 

 

Click OK.  You will be brought back to the Directory 
Manager where you may choose the correct school 
year. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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10. Click OK. 

 

If you have previously generated the current 
document, the program will assume you want to 
store it in the directory previously chosen.  If you 
wish to save the current document in a different 
location or wish to rename it, you may do so after 
pressing Generate but prior to pressing OK.  

If you choose to store the current document in the 
previously selected directory and do not rename it, 
you will be prompted as to whether or not you 
want to overwrite the previously generated 
document. 

Hint:  If you are unsure which to option to select, 
press No or Cancel and contact your Tranquility 
Administrator regarding your business processes. 

 

Select: 

• Yes to overwrite the previously generated document, or 

• No or Cancel to terminate generation of the document. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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11. Click OK.  Tranquility will start Microsoft Word remotely if 
it is not currently running.  You will notice a Please Wait… 
message box in the upper right hand corner of your screen as 
the program creates the output.  The completed document 
will appear on your screen when completed.  If not, you can 
simply click on Microsoft Word on your taskbar. 

 
This is a word processing document that you can 
edit.  If you need to change any data that you 
provided, it is recommended you return to 
Tranquility to make the changes permanent.  Any 
changes made in the word processing document 
are only temporary. 

• 

• 

• 

To print the document, from the File menu, 
select Print.   
Prior to returning to Tranquility, it is 
recommended that you close the open 
document(s) by selecting Close from the File 
menu. 
To return to Tranquility, click on the 
Tranquility icon on the taskbar. 

Hint:  It is not recommended that you exit (i.e., 
Do not choose Exit from the File menu.) 
Microsoft Word each time you return to 
Tranquility if you intend to generate additional 
documents.  Doing so, will increase generation 
time. 

12. If you want to: 

• Continue working with the current portfolio, press 
Provide Answers to resume the question and answer 
interactive session, or Generate to create additional 
documents. 

• Work in another portfolio, from the File menu choose 
Close. 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 
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13. To close Tranquility, select File then Exit from the menu 
bar. 

 

Notes 
________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

________________________________ 

 

     

Each time you update a student’s portfolio, the Date/Time stamp is updated in the File-Open 
window 

 
. 
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General Notes 
 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 
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Activity 1 

Goal:  Create a New Portfolio 

Purpose:  Every student in Tranquility should have his/her own portfolio.  A portfolio needs to 
be created once per student as it can “follow” the student until he/she exits special education. 

1. From the File menu, select New. 

2. Highlight the desired questionnaire and click OK. 

3. Select the name of the student for whom you are creating the portfolio by highlighting their name 
and pressing the ENTER key.  You will notice that the student you selected now appears in the 
right hand box on the screen (Figure 1.1).   

4. Click OK. 

5. Highlight the directory in which you wish to save the portfolio (e.g., Portfolios). 

6. Click OK.   

Figure 1.1 

 

 
 
Notice that the 
student you 
selected now 
appears in the 
right hand box on 
the screen. 
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If you were successful your screen should look like Figure 1.2. 

Figure 1.2 

Hint: Name 
should be the 
same and should 
not have more 
than one student 
name in the 
people box 

 

 

Student Name – PF 

Questionnaire 

Students’ Names associated with this 
portfolio appear here.  If additional names 
are in the “People” box, it is strongly 
suggested you contact your Tranquility 
Administrator to verify your business 
processes. 
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If you were unsuccessful… (See Figure 1.3) 

• You will see the following Message (Figure 1.3) 

• Click OK.  Then highlight and Double Click the selected student to the right hand side of the 
box.  You can then proceed to create the Portfolio in the Portfolios directory. 

Figure 1.3 

 
 
 
 
 

 

7. Once you have successfully created a portfolio, select Close from the File menu. 
 
 
 
 
 
 
 

I have successfully completed this activity. 
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Activity 2 

Goal:  Open an Existing Portfolio 

Purpose:  Once a portfolio has been created for a student in Tranquility you will update it 
with information.  This simply requires opening the portfolio. 

1. From the File menu, select Open. 

2. Highlight the name of the student portfolio that you want to open. 

Note:  If you do not see the name of the desired portfolio, you may want to check the 
subdirectories (e.g., 2003/2004 Documents) to ensure that it has not been previously created 
and saved in a non-root directory. 

3. Click OK. 

If you were successful your screen should look like Figure 2.1. 

Figu re 2.1 

 
 

I have successfully completed this activity. 
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Activity 3 

Goal:  Select a Different Questionnaire 

Purpose:  Once a portfolio has been created for a student in Tranquility you can provide 
answers for any questionnaire that has been created for your district.  If a questionnaire has 
been created but you do not see it in the list of available questionnaires, you may have been 
restricted via security. 

Note: A portfolio must be open before you can select a different Questionnaire.  See Activity 2 
for more information. 

1. Click on the Questionnaire drop-down menu. 

 

 
 
 
 
This is the 
Questionnaire 
drop-down menu. 

Your district may 
only have one 
questionnaire. 
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2. Click on the name of the Questionnaire that you want to use. 
 

 
 

Questionnaire 
drop-down 
menu 
expanded. 

 

The newly selected questionnaire now appears in the Questionnaire field. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I have successfully completed this activity. 
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Activity 4 

Goal:  Provide Answers – Input Data 

Purpose:  Once a portfolio has been created for a student in Tranquility you will input 
information by responding to questionnaires.  This is where a majority of your time will be 
spent. 

Note: A portfolio must be open before you can Provide Answers.  See Activity 2 for more 
information.   

In addition, please select the Questionnaire that represents the IEP for your district.  See Activity 3 
for more information. 

1. Press the Provide Answers button located in the top left of your screen. 

2. You will see the first question for the questionnaire.  Please see the training handouts that 
describe the different question types for more information. 

3. Experiment with the Navigation Buttons and the associated keyboard shortcuts (F5, F7, 
F8 and F9). 

4. Answer one question of each type (date, text, multiple choice, list choice, and external 
programs).  As for the external program questions, please experiment with both core 
reporting screens and goals and objectives. 

5. Once you have answered each type of question, press the End button. 

 
 
 
 
 
 
 
 
 
 

I have successfully completed this activity. 
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Activity 5 

Goal:  Generate a Document 

Purpose:  Once a portfolio has been created for a student in Tranquility and you have 
provided answers, either partially or completely, you will want to preview and perhaps print 
a document.  The documents are based on the format of your paper forms as appropriate. 

Note: A portfolio must be open before you can Generate a document.  See Activity 2 for more 
information.   

In addition, you may want to Provide Answers prior to generating a document.  The process does 
not change only the output, as it is dependent on your responses.  See Activity 4 for more 
information. 

1. Press the Generate button located in the top left of your screen. 

2. Select a document to generate. 

3. Press OK. 

4. Select a subdirectory to save the document.  Verify that you are saving the document in a 
recommended subdirectory. 

Hint:  If you press OK after selecting a subdirectory to save the document in and you receive 
a system message warning of your action, you have not selected a recommended 
subdirectory. 

Note:  After you select a subdirectory to save the document you just wait until the completed 
document appears on your screen.  This is your signal that processing is complete.  If you 
have activated other applications during processing, you may need to click on Microsoft 
Word on your taskbar. 

5. Preview the completed document in Word.  Upon completion of preview (and printing if 
desired), choose Close from the File menu. 

6. Return to Tranquility by clicking on the Tranquility icon on the taskbar. 
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7. From the File menu, choose Close.  You should now be at the main Tranquility program 
screen (See Figure 5.1). 

Figure 5.1 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I have successfully completed this activity. 
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Activity 6 

Goal:  Open Previously Generated Documents 

Purpose:  Once a document has been generated, it may become necessary for other users to 
view the document.  Subsequent teachers. Special Education Administrators, principals, etc. 
may, at different times during the school year need to read, review a student’s 
documentation.  

Note: A document must be generated prior to attempting to open the document.  See Activity 5 for 
more information.   

 

1. From the File menu, select Open. 

2. Highlight the name of the student whose document you want to open. 

3. In the lower left hand corner of the screen, change the Directory selected from Portfolios 
to Documents. 

4. Click the subdirectory in which the document was saved. 

5. Find the document name you are trying to open. 

6. Highlight the document name and press OK. 

7. The document selected will open in Word. 

8. Upon completion of viewing the document, choose Close from the File Menu in Word. 

9. Upon completion of viewing (and printing if desired) of the document, choose Close from the 
File Menu on the Tranquility taskbar. 

 

 

 

 

 

 

 

 

 
I have successfully completed this activity. 
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Activity 7 

Goal:  Repeat Previous Activities Successfully 

Purpose:  To successfully learn new tasks, repetition is vital.  Challenge yourself to repeat 
the activities for additional students referring to handouts and notes as little as possible. 

• Think of the different scenarios that you are faced with currently as you complete your 
required case management documentation.  Attempt to create these same scenarios as you use 
the program. 

• Ask your trainer for helpful hints in how to navigate through the program quicker.  Both 
hands on the keyboard are faster than one on the mouse. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I have successfully completed this activity. 
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6.  Common System Messages 

This chapter provides you with a sample of common user or configuration system messages or errors 
that you may encounter as you train or use the Tranquility Case Management software.  The sequence 
is the order in which they commonly occur.  With the exception of the Stop Sign Error Message, the 
following are a result of incorrect system configuration or user error. 

Account Not Found or Password Not Found 
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Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Log in 1. User is clicking (with mouse) in the 
Account/Password cell and is not left 
justified prior to entering information 

 

 

 

 

2. User does not exist in system. 

1. Encourage user to not click with mouse after 
double clicking on icon.  The program will 
default to location where user can start 
typing in account. 

-or- 

Press Home after clicking in the 
account/password cell, before entering 
account/password. 

2. Create the user an account. 
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Trying to Save a Portfolio 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

File New 
process 

1. User selected a directory to save the 
portfolio other than the Portfolios main 
directory. 

1. Press OK and click on the Portfolios 
directory.  Then press OK. 
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Attempting to Generate a document 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Generate 
process 

1. The Default Settings for the Directory to 
Save Documents is incorrect. 

1. Press OK and select Default Options 
from the Options menu. 

• 

• 

• 

Ensure the Directory to Save 
Documents line contains 
DOCUMNTS\ only.  Do not include 
the path prior to this level, as it may 
not be appropriate for all users. 

Press OK. 

Generate the document. 
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Trying to Save Documents in the Main Portfolios Directory 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Generate 
process 

1. User selected a non-document-designated 
directory.  It is recommended that all 
documents are store on a yearly basis for 
easier retrieval. 

1. Press OK and select a School Year 
directory, then press OK. 
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Cannot Connect to Word Processor when Generating a Document 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Generate 
process 

1. The Default Settings for the Word 
Processor Executable is incorrect. 

 

1. Press OK and select Default 
Options from the Options 
menu. 

• 

• 

• 

• 

• 

Locate the Word Processor 
Executable line and press 
the Browse button.   

Navigate to the 
WINWORD.EXE. 

Press Select. 
Press OK. 

Generate the document. 

2.   You can reset the Microsoft 
Word executable path.  
Tranquility 5.0 stores the path 
you set with your account ID 
so that when you log in, it 
knows where your executable 
is located.  To set the path, 
perform the following steps. 

• Close your portfolio. 

• From the Options 
menu, choose 
Change Word 
Processor Path.  
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The following window 
appears: 

 

 

 

• Press Browse.  The following window appears: 

 

 
• Navigate to your winword.exe file.  Generally the file 

is located similarly to the path in the screen shots 
above. 

• Press Select. 
• Press OK. 

• Open the portfolio and regenerate the document. 
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Adding/Selecting a Student for which a Portfolio and Questionnaire 
Combination Exists 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

File New 
process 

General 
manipulation of 
the portfolio 
main screen 
(user 
experimenting 
with the Add 
button) 

1. User selected multiple students for the 
same portfolio. 

1. Highlight the student’s that were 
incorrectly selected and press Delete on 
the screen.  Follow remaining prompts 
appropriately. 

 

82 For Software Version 5.0 



6.  Common System Messages 
 
 
 

 Goals and/or Objectives Contain Double Quotes 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Generate 
process 

1. Goals and/or Objectives contain double 
quotes (“). 

1. Remove all double quotes from goals and 
objectives.  If the user received the goals 
and objectives from the district lookup 
banks, the double quotes should be 
removed from the banks as well.  
Remember to redistribute the associated 
goals and objectives tables if this is the 
case. 
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User receives a Stop Sign 
WARNING:  It is not recommended to reboot or turn off your computer if you receive a 
STOP sign message (or a consistent beeping signal), which indicates there is an error.  Rebooting or 
turning off your computer when this occurs will likely result in damaged files.  This may further 
complicate your situation. 

If you happen to receive a STOP sign, do the following: 
1. Make a note of what you were doing when it appeared. 

2. Press the OK button 

3. At the "Would you like to view the error log file now?" message, press the Yes 
button 

4. Make a note of what the error log displayed. 

5. While pressing the <CTRL> button, press the letter Q.  This will exit you from Tranquility. 
 

If your computer has "locked up" or is beeping: 
1. Press Ctrl+Alt+Delete keys at the same time - the Task List should appear. 

2. Click on the Tranquility task 

3. Press the End Task push button 
 

If neither suggestion solves your situation, contact your Tranquility Administrator. 
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Structural Index Missing 

 

Commonly 
Occurs 
During 

Cause(s) Solution(s) 

Use of 
program if a 
file has been 
damaged or 
is missing. 

1. Hardware failure, program terminated 
while database is left open (e.g., laptop 
goes into sleep mode, power surge or 
failure) 

2. Files missing, moved from anticipated 
directories 

1. Do not use the program until permitted by 
your Tranquility Administrator. 

2. Start Tranquility Case Management and 
Run Housekeeping (See Tranquility Case 
Management User’s Manual for more 
information).   

• If you receive a Stop Sign during 
Housekeeping, make note of which 
table was being updated when the 
Stop Sign appeared.  Contact your 
Tranquility Administrator and inform 
him/her of the information you have 
gathered and the results of running 
Housekeeping. 
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7.  One Page Summaries 

How to Create an Electronic Portfolio 
Note:  Windows must be running before you can start Tranquility. 

1. Double click on the Tranquility icon.  

2. When prompted, enter your Account and press Enter.  Then enter your Password, and 
click OK. 

3. From the File menu, select New. 

4. Highlight the questionnaire you wish to use then click OK. 

5. Select the name of the student for whom you are creating the portfolio by highlighting their 
name and pressing the ENTER key.  You will notice that the student you selected now 
appears in the right hand box on the screen. 

6. Click OK.  

7. Highlight the Portfolios directory. 

8. Click OK.  

9. To begin answering questions within the questionnaire, click on the Provide Answers push 
button at the top of your screen. 

10. Answer each question. 

• Press F8 to go to the next question or click on the Next push button in the Question box 
at the bottom of your screen 

• Press F7 to go to the previous or click the Previous push button in the Question box at 
the bottom of your screen. 

• The F9 key will access the designated hot key question (e.g., Case Conference notes).  
Press F9 once to jump to the designated question.  After reviewing/providing information 
on the designated question screen, press F9 again to return to the question from which 
you left. 

• F5 will display an entire multiple or picklist choice once highlighted in the available 
choice list.  F5 also displays the available lookup lists on the Goals and Objectives 
screen. 
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11. When you have completed answering all of the questions, a message will appear alerting you 
that you have reached the end of the questionnaire. 

• If you are finished with this questionnaire and answer session, click OK.  This option 
will return you to the main portfolio screen. 

• If you would like to remain in the questionnaire, select the “Remain with this 
person” radio button, and then click OK. 

12. Once you have finished with the questionnaire and have returned to the main screen, to view 
and/or print your portfolio component, you simply click on the Generate push button 
located at the top of your screen. 

13. Select which document you would like to generate by highlighting its title and clicking OK. 

14. Highlight the directory in which you would like to save this document (e.g., 2003-2004 
Documents). 

15. Click OK. 

16. The document is created in Microsoft Word.  This is a word processing document that you 
can edit and update the information.  To print the document, from the File menu, select 
Print.  To return to Tranquility, first choose File then Close.  Next, hold down the Alt key 
on your keyboard and press Tab until the Tranquility icon is selected, and then release Alt 
key.  (To make changes permanent you must change answers in Tranquility.) 

Note:  It is not recommended that you exit (i.e., Do not choose Exit from the File menu.) 
Microsoft Word each time you return to Tranquility if you intend to generate additional 
documents.  Doing so, will increase generation time. 

17. If you want to: 

• Continue working with the current portfolio, press Provide Answers to resume the 
question and answer interactive session, or Generate to create additional documents. 

• Work in another portfolio, from the File menu choose Close. 

18. To close Tranquility, select File then Exit from the menu bar. 
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How to Update an Existing Electronic Portfolio 
Note:  Windows must be running before you can start Tranquility. 

1. Double click on the Tranquility icon.  The following window appears: 

2. Enter your Account and press Enter.  Then enter your Password, and click OK. 

3. From the File menu, select Open. 

4. Highlight the name of the student portfolio that you want to open. 

5. Click OK. 

6. To begin answering/changing questions within the questionnaire, click on the Provide 
Answers push button at the top of your screen. 

7. Answer each question. 

• Press F8 to go to the next question or click on the Next push button in the Question box 
at the bottom of your screen 

• Press F7 to go to the previous or click the Previous push button in the Question box at 
the bottom of your screen. 

• The F9 key will access the designated hot key question (e.g., Case Conference notes).  
Press F9 once to jump to the designated question.  After reviewing/providing information 
on the designated question screen, press F9 again to return to the question from which 
you left. 

• F5 will display an entire multiple or picklist choice once highlighted in the available 
choice list.  F5 also displays the available lookup lists on the Goals and Objectives 
screen. 

8. When you have completed answering all of the questions, a message will appear alerting you 
that you have reached the end of the questionnaire. 

• If you are finished with this questionnaire and answer session, click OK.  This option 
will return you to the main portfolio screen. 

• If you would like to remain in the questionnaire, select the “Remain with this 
person” radio button, and then click OK. 

9. Once you have finished with the questionnaire and have returned to the main screen, to view 
and/or print your portfolio component, you simply click on the Generate push button 
located at the top of your screen. 

10. Select which document you would like to generate by highlighting its title and clicking OK. 

11. Highlight the directory in which you would like to save this document (e.g., 2003-2004 
Documents). 

12. Click OK. 
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13. The document is created in Microsoft Word.  This is a word processing document that you 
can edit and update the information.  To print the document, from the File menu, select 
Print.  To return to Tranquility, first choose File then Close.  Next, hold down the Alt key 
on your keyboard and press Tab until the Tranquility icon is selected, and then release Alt 
key.  (To make changes permanent you must change answers in Tranquility.) 

Note:  It is not recommended that you exit (i.e., Do not choose Exit from the File menu.) 
Microsoft Word each time you return to Tranquility if you intend to generate additional 
documents.  Doing so, will increase generation time. 

14. If you want to: 

• Continue working with the current portfolio, press Provide Answers to resume the 
question and answer interactive session, or Generate to create additional documents. 

• Work in another portfolio, from the File menu choose Close. 

15. To close Tranquility, select File then Exit from the menu bar. 
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Reference Cards 
To start a new portfolio 

1. Choose New from the File menu  
2. Select a questionnaire 
3. Press OK 
4. Select one student, press OK 
5. Press OK 
6. Press Provide Answers 

Goals and Objectives Screen 
 Press TAB to move around the screen forward,  SHIFT 

+ TAB to move backward 
 Use F5 for lookups 
 Press Save Goal before exiting screen 
DO NOT USE DOUBLE QUOTES (") IN ANY OF YOUR 
ANSWERS! 
Shortcuts 

 F5     Allows you to view entire multiple choice/list    
           options that are lengthy 

 F8     Next question 
 F7     Previous Question 

F9     HOT KEY - Takes you to case conference notes 
and back 

Definitions 
 Portfolio - like a hanging file folder 
 Questionnaire - like a manila folder 
 Documents - generated from questionnaires 

 
Security 
 If you must leave your computer unattended for a 

short amount of time, you may lock Tranquility via 
the Options – Screen Lock function.  This will 
freeze the application until your password is 
entered.  This function is not available within a 
questionnaire.  For greater security, it is always 
recommended to log out of the application 
completely. 
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To start a new portfolio 

1. Choose New from the File menu  
2. Select a questionnaire 
3. Press OK 
4. Select one student, press OK 
5. Press OK 
6. Press Provide Answers 
 

Goals and Objectives Screen 
 Press TAB to move around the screen forward,  SHIFT +
 TAB to move backward 
 Use F5 for lookups 
 Press Save Goal before exiting screen 
 
DO NOT USE DOUBLE QUOTES (") IN ANY OF YOUR 
ANSWERS! 

Shortcuts 
 F5     Allows you to view entire multiple choice/list options 
          that are lengthy 

 F8     Next question 
 F7     Previous Question 

F9     HOT KEY - Takes you to case conference notes and 
back 

Definitions 
 Portfolio - like a hanging file folder 
 Questionnaire - like a manila folder 
 Documents - generated from questionnaires 
 
Security 

 If you must leave your computer unattended for 
a short amount of time, you may lock 
Tranquility via the Options – Screen Lock 
function.  This will freeze the application until 
your password is entered.  This function is not 
available within a questionnaire.  For greater 
security, it is always recommended to log out of 
the application completely. 
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GLOSSARY 
 

 
Action Buttons – buttons found at the bottom of Core Reporting screens, when seen in Case 
Management, which define the actions that the user can take on the screen.  Accessible buttons 
may vary depending on the user’s security rights. 
 
Archive – the movement of student data from the active dataset to the inactive dataset; historic 
data may be moved back from the inactive dataset to the active dataset if the student returns 
 
Case Management – The component of Tranquility for Special Education that collects information 
for Special Education documentation and generates documents based on the information collected. 
 
Core Reporting – The component of Tranquility for Special Education that houses the Special 
Education information required for federal and state reporting. 
 
Date Field – data entry field which is completed by entering 8 character date (DDMMYYYY). 
 
Demographic Information – Information relating to the student’s ID number, school, and 
Parent/Guardian information.  In Tranquility, this information is usually pulled from the district’s SIS. 
 
Directory – a listing of the files stored in memory (usually on a hard disk).  In Case Management, 
the directories are defined as the portfolio directory in which all student portfolios are stored and 
individual school years in which student documents are stored. 
 
District Integration – overnight process which updates school and district Tranquility information 
so the information matches; D.I. is also used to update student demographic information from the 
SIS.  
 
Document – the completed MS Word form (IEP, progress chart, etc.) 
 
Ellipsis – button used on screens to access tables with codes and descriptions; assists with data 
entry 
 
Executable - a file (always a program of some kind) that can be run by the computer directly.  In 
Case Management, Tranquility must be able to find the executable associated with Microsoft 
WORD in order to generate documents (IEP, letters, progress charts). 
 
External Questions – questions in Case Management that access the Core Reporting Screens.  
They require a SAVE before leaving the screen and often contain lists for data entry found behind 
ellipsis buttons. 
 
FoxPro - the database system Tranquility for Special Education version 5.0 is based on. 
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Generate – merging of questionnaire template with answers provided to obtain document. 
 
GOTO – in Case Management, the GOTO button accesses the list of unindented questions in the 
questionnaire, allowing users to skip from one question to the next without having to navigate 
through all of the questions in between. 
 
Housekeeping – process of reindexing files to optimize database performance. 
 
Include in CM – check box on Core Reporting screens which indicates that data from a record will 
be included in Case Management document creation. 
 
List Box – in Core Reporting screens, the box which houses the list of saved records for a student.  
Each line item in the list box will reflect a saved record (i.e. referral date, placement changes, etc.).  
Details are obtained by highlighting each line item in the list.  
 
Lookup Field – data entry field which is completed by accessing an ellipsis button. 
 
Mark Students – process which flags a student record for transmission during the District 
Integration process. 
 
Multi-Select – the ability within Tranquility for Special Education to choose more than one selection 
in a list at one time.  
 
Multi-Section Screen – Core Reporting screens that contain two data entry areas within the 
screen.  The Assessment screen is an example of this type of screen as it has two sections, a 
header and detail.  These screens allow for two ADD processes and may require 2 SAVE comands 
to complete. 
 
Navigational Buttons – buttons found on the bottom of questionnaire screens in Case 
Management to assist the user in “navigating” or moving through the screens. 
 
Portfolio – an electronic cumulative folder; one student’s data is stored in a portfolio.  Students 
should only have one portfolio created. 
 
Questionnaire - sequenced set of questions used in Case Management to create data for 
generation of the IEP. 
 
SIS – Student Information System; the district’s student data tracking system such as SASIxp. 
 
Text Field – data entry field which is completed by typing in text; no table is accessed. 
 
Transmit to District/School – indicates the student record has been marked for update during 
District Integration; at schools student record will say “Transmit to District” and at the district will say 
“Transmit to School”; record is automatically marked when Add/Edit are chosen, and record is 
saved. 
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Word Processor - an application that provides the user with tools needed to write, edit, and format 
text; and to send it to a printer.  In Tranquility for Special Education all users must have access to 
Microsoft Word. 
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